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Module 6: Animation

Module Six: Animation

Animation was introduced in Module 5 when we studied slide transitions. This

module will demonstrate other forms of slide animation. Animation can be a powerful

way to keep audience attention. But too much of it will cause the audience to lose
sight of the presentation material. Use animation with caution. The module
concludes with a discussion of the skills needed to prepare the presentation for
delivery to an audience.

Topics

Animation

Slide Sorter View
Slide Show Set Up
Starting a Slide Show
Presenter Notes
Audience Handouts

Exercises

Exercise 6A — Animation
Exercise 6B — Custom Animation
Exercise 6C — Slide Sorter
Exercise 6D — Start a Slide Show
Exercise 6E — Notes

Objectives
At the end of this module participants will be able to:

1. Apply animation to slide elements

N o gk~ b

Use Slide Sorter view to change slide order.
Use Slide Sorter view to delete a slide.

Set up a slide show to run in a continuous loop.

Start a Slide Show.
Create presenter notes.
Create and print audience handouts.
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Animation

Without animation text and objects appear on a slide and remain motionless.
Animation can be used to draw viewer attention to text or objects. Animation tools
are found on the Animations tab, Animations group.
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Figure 6.1 Animations Tab

Use the Animate option to display bulleted list items one at a time.
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Figure 6.2 Animate Option on Text

In the example shown above the bulleted list was selected and Fade By 1°' Level
Paragraph was clicked. Moving the mouse over the choices provides a preview.

As shown on the right, the list is now displayed one at a time by fading in to
appearance.

This causes your audience’s attention to be drawn to the text and read it as it
appears.
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Animation can also be added to objects on a slide. In the example below all objects
have been selected and Fly In is clicked. This will cause all objects on the slide to fly
up from the bottom of the slide.
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Figure 6.3 Animate Option on Objects

The audience will be drawn to the movement. Use caution in assigning this form of
animation. Used on too many slides may diminish its ability to keep audience
attention. Instead it becomes a distraction and can cause loss of focus on the
presentation’s content.

Exercise 6A — Animation

This exercise will give you a chance to add animation to the Garden Club Plant Sale
presentation.

Open the Garden Club presentation.

Select a slide that contains a bulleted list.

Animate this list trying all of the Fade, Wipe and Fly In options.

Select a slide that contains objects.

Animate these objects trying all of the Fade, Wipe and Fly In options.

Save your work to your flash drive.

Do not close PowerPoint.
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Click on the Preview option any time you want to be shown the animation assigned
to a slide.
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Custom Animation
Custom animation allows more animation choices and control over animation

effects. The process starts by selecting the text or objects you wish to animate. Then
select the Custom Animation option.
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Figure 6.4 Custom Animation

Notice the Custom Animation task pane on the right side of the graphic above. This
is where we will select the custom animation effects we desire.

In the example below we have decided to have the selected objects enter in a
Diamond pattern.
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Figure 6.5 Entrance Animation
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Use the Play button on the Custom Animation task pane to preview the animation
scheme you have selected.
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Figure 6.6 Play Button

Exercise 6B — Custom Animation

In this exercise let’s take our animation to a new level.

Open the Garden Club presentation.

Select a slide that contains objects.

Select an object and assign it an Entrance option.

Select the next object and assign it a different Entrance option.
Do this for all objects on the slide.

Use the Play button to preview you selected animation.

Save your work to your flash drive.

Do not close PowerPoint.
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To remove an animation, select the object and click the Remove button.
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This completes the course material that deals with slide show content. We now
move to the portion of the course that provides tips on preparing the presentation for
delivery to an audience.

Slide Sorter View

The Slide Sorter view displays a thumb nail view of all slides in a presentation. It
gives us a handy way to see all slides in the order they will be presented. Using
“‘drag and drop” we can rearrange the slide order. Slides can also be deleted when
in Slide Sorter view.
There are two ways to enter Slide Sorter view.
e Click on the Slide Sorter icon on the View tab, Presentation Views group
e Click on the Slide Sorter View Button
They are shown below.
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Figure 6.7 Slide Sorter
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If we wish to change the order of a slide in a presentation, select it and “drag and
drop” it to the new location.

Figure 6.8 Change Slide Order

In the example above slide number 8 was moved to appear before slide number 7.
To delete a slide select it and press the Delete key on the keyboard.

Exercise 6C — Slide Sorter

Use this exercise to practice rearranging slide order.
Open the Garden Club presentation.

Enter Slide Sorter view.

Change the order of slides.

Delete a slide.

Save your work to your flash drive.

Do not close PowerPoint.
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Slide Show Set Up

Now that we have completed the slide show, one final step is to establish how it will
be presented. Set Up options are found in the Set Up group of the Slide Show tab.
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Figure 6.9 Set Up Group
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In almost all cases the default slide show settings will meet your needs. To change
the defaults click on the Set Up Slide Show icon. The options are shown below.
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Figure 6.10 Set Up Options

The options of interest to us are in the following categories:

Show Type — The default is Presented by a speaker. This is the option you
would select if you are delivering the presentation to a group.

Show Options — If you wish to start a presentation and have it run in a continuous
loop, select Loop Continuously until” Esc”. This option is sometimes selected when a
Photo Album is shown at a gathering. Narration and animation can be turned off for
a particular presentation.

Show Slides — Here you can select all or selected slides to be displayed in your
presentation. Use this to customize a presentation.

Advance Slides — The default is to use slide advancement based on timing you

may have established or manual advancement if that is not present. Slide timing is a
topic we did not cover.
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Starting a Slide Show

Now that the presentation has been created it is ready for viewing. There are many
ways to start the presentation:
e Select From Begining on the Start Slide Show group of the Slide Show
tab.
e Depress the F5 key on the keyboard.
e Click on the Slide Show icon on the View Buttons area of the status bar. Note:
this option will start the slide show from the current slide, which might not be
the first slide.

Ca = = Garden
Home Insert Design Animations Slide Show Review Vie ra— ’
oo | - '
== Te e oz »9 Record Narration ‘ E oo ?&78% {
P | & | T e &Y - \ S
o o s = &Y Rehearse Timings i =
From % From Custom Set Up Hide 7 S5
Beginning Current Slide = Slide Show ~ || Slide Show Slide Use Rehearsed Timings A
Start Slide Show Set Up

Figure 6.11 Start Slide Show Options

Once the show begins, the Enter Key, space key, or clicks of the left mouse button
can be used to advance through the presentation. You can also use keyboard arrow
keys (Right and Down = advance, Left and Up = go Backward) to move through the
presentation

A right mouse click during the slide show brings up the menu show on the slide
below.
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Figure 6.12 Right Click Options
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The most common use of these menu options is to:

Advance to the next slide

Back up to the previous slide (Note: the Backspace key can also be used)
Go to a particular slide

Cause the screen to go to black or white

Change pointer options

End the show (Note: the Esc key can also be used)
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Pointer Options » White Screen End Show
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Switch Programs
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End Show [ oy A

Figure 6.13 Right Click Options — Expanded

Exercise 6D — Start a Slide Show

This exercise will help you prepare for next week’s class presentation.

ONOoOORWDNE

Open the Garden Club presentation.

Start the slide show.

Use one of the options described to advance through the first five slides.
Use the Backspace key to return to slide four.

Use an arrow key to return to slide three.

Use a “right click” to return to slide two.

Continue advancing through the entire slide show.

Do not close PowerPoint.
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Notes

You may have noticed that the bottom of each slide we created there was an area
that says “Click to add notes”. This area is called the Notes Pane. You can use
Notes Pane to create speaker notes. These notes will help remind you of your
talking points for each slide. These notes will be visible to only you during the
presentation.

The Notes Pane can also be used to create handout notes for your audience, more
on that in the next section of this module.
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Figure 6.14 Notes

Notes have been added to the slide shown above. When you present you can refer
to these notes and not have to remember that the Morning Glory is a vine.

Anything you want to remember can be placed in a note.

All PowerPoint text formatting options apply to the notes you type.
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Use the Notes Page view to display your notes.
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Figure 6.15 Notes Page View

Notes can also be added while in the Notes Page view.

Exercise 6E — Notes

Speaker notes can help a presenter remember a presentation’s important points.

Ok whPE
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Open the Garden Club presentation.

Select a slide and add notes (don’t worry about content).
Select the Notes Page view.

Save your presentation to your flash drive

Do not close PowerPoint.
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Printing
Your slide show may be printed. You might want to have a copy for your own use or
to use as a handout for the audience.

To print, select Print from the Office Button.
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Figure 6.16 Office Button — Print

The print dialog is displayed.
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Figure 6.17 Print Dialog
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In the Print What dialog box is a list of what can be printed:

Slides — Prints each slide in the presentation.

Notes Pages — Prints slides and speaker notes. This could be used as an audience

handout or could be used just as notes for the speaker.
Handouts — Prints slides to be used as an audience handout. You can select to

have from 1 to 9 slides printed horizontally or vertically on a page. Printing multiple

slides on a page conserves paper. A typical choice would be to print from 4 to 6
slides per page.
Outline View — Prints an outline of the presentation.

Module Summary
In this module you gained the skills needed to:

Apply animation to slide elements

Use Slide Sorter view to change slide order.
Use Slide Sorter view to delete a slide.

Set up a slide show to run in a continuous loop.
Start a Slide Show.

Create presenter notes.

Create and print audience handouts.

Homework

Spend some time this week completing your presentation. Try to incorporate as
many of the skills you have gained during this course. If appropriate include:

Clip art/pictures
Sounds/movies
Charts

Tables

WordArt

Text boxes
Transitions
Animation
Select a Theme

Next week you will deliver your presentation to the class, so practice
your slide show.
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Save your presentation to your flash drive and remember to bring it to class next
week.
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